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Financial Statement
Analysis
In this chapter you will learn:
• How to perform a vertical financial analysis
• How to create a pie chart of expenses
• How to perform a horizontal financial analysis
• How to create a column chart of expenses
• How to calculate financial ratios

Case: What SUP, Inc.
Nathan and Meagan are ready to evaluate the company’s performance, examine
trends and relationships, and assess liquidity and solvency. Kyle suggests three
forms of analysis that can provide information to Nathan and Meagan for business decision making: vertical, horizontal, and ratio analysis.
You recall learning about these three methods of analysis while studying financial accounting. Kyle reminds you that Excel is a great tool for preparing
these analyses and suggests that you take the lead in explaining the formulas
used in creating these types of worksheets.
‘‘Can Excel also help us prepare charts? We have to prepare some information
for our bankers, and they seem to prefer both numbers and charts,’’ Nathan asks.
‘‘Most definitely!’’ Kyle answers. ‘‘We’ll use Excel to look at the financial information we recently created, and then we’ll compute vertical, horizontal, and ratio
analyses as well as prepare charts to describe important relationships and trends.’’

Video Demonstration

DEMO 3A Vertical analysis
with a pie chart

Vertical Analysis
Vertical analysis, often referred to as component analysis, is used to express
each item on a particular financial statement as a percentage of a single base
amount. In an income statement, the base is sales revenue. Each expense is
expressed as a percentage of sales revenue. Meagan seems very interested in
comparing what percentages of revenues are spent on various expenses and
how that compares from one period to the next.

To create a vertical analysis on an income statement:
1 Click File and then click Open.
60
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2 Navigate the Open window to the location of this text’s student files.
(The location would be the CD provided with the text or from your
computer lab’s server.)
3 Double-click the file ch3-01, which should be located in a Ch 03
folder.
4 Click the Income Statement tab.
5 Right-click column C and click Insert to insert a new column.
6 Click cell C4 and type % as a label to the new column.
7 Click cell C5 and type the formula =B5/$B$5; then press [Enter].
(Note: use an absolute reference in the denominator so you can fill
down the formula later.)
8 Click cell C5 again and reformat the cell by clicking the % tool in
the Number group of the Home tab.
9 Resize column C to reveal all values.
10 Fill down the formula in C5 to C16 by dragging the handle in the
lower right corner of cell C5 to C16. (Note: this will also copy down
the formatting from cell C5, removing border formats that you can fix
later.)
11 Eliminate the formula from cell C8 by clicking the cell and pressing
[Delete], then [Enter].
12 Add appropriate border formats to cells C6, C13, and C16.
13 Repeat Steps 6 to 11 in column E, substituting E for C in all column
references. Substitute D for B in the formulas. Your worksheet should
look like Figure 3.1.

Figure 3.1
Income Statement
Vertical Analysis

14 Click File again and then click Save As. (This preserves your original
student and provides a unique name for your file.)
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15 Change the file name to reflect the vertical analysis just performed
and your name by using the underscore key as before. In this example,
the file will be saved as ch3-01_Vertical_Analysis_student_name
(replace student_name with your name). Save your file to a location
(e.g., a USB drive) from which you can retrieve it later.
16 Switch to a Page Layout view. Place your name in the left section of
the footer. Note that the file name is already in the right section of the
footer.
17 Switch back to a Normal view.
18 Click File and then click Print to make sure the worksheet will print
the way you want.
19 Click Print to print your analysis.
20 Save your file once again but do not close it.
Meagan is pleased that Excel can produce these amounts so quickly. She
notes that the firm’s gross profit percentage is down from the previous year and
that the cost of goods sold as a percentage of sales is higher. This helps explain
the reduction in net income as a percentage of sales.
‘‘Is the balance sheet used for vertical analysis as well?’’ Nathan asks.
‘‘Yes,’’ you respond.
In a balance sheet the base is total assets. Each asset, liability, and equity
component is expressed as a percentage of total assets.

To create a vertical analysis on a balance sheet:
1 Click the Home tab and then click the Balance Sheet worksheet tab.
2 Right-click column C and click Insert to insert a new column.
3 Click cell C5 and type % as a label to the new column.
4 Click cell C7 and type the formula =B7/$B$17, then press [Enter].
(Note: Once again, use an absolute reference in the denominator so
you can fill down the formula later.)
5 Click cell C7 again and reformat the cell by clicking the % tool in
the Number group of the Home tab.
6 Resize column C to 61 pixels.
7 Fill down the formula in C7 to C17 by dragging the handle in the
lower right corner of cell C7 to C17. (Note: This will also copy
down the formatting from cell C7, removing border formats that you
can fix later.)
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8 Eliminate the formula from cell C12 by clicking the cell and pressing
[Delete], then [Enter].
9 Add appropriate border formats to cell C17.
10 Repeat Steps 3 to 9 in column E, substituting E for C in all column references. The asset part of your worksheet should look like Figure 3.2.

Figure 3.2
Balance Sheet Assets
Vertical Analysis

11 Save your work.
12 Click cell C22 and type the formula =B22/$B$29; then press [Enter].
(Note: Again, use an absolute reference in the denominator.)
13 Click cell C22 again and reformat the cell by clicking the % tool in
the Number group of the Home tab.
14 Fill down the formula in C22 to C29 by dragging the handle in the
lower right corner of cell C22 to C29. (Note: This will also copy
down the formatting from cell C7, removing border formats that you
can fix later.)
15 Eliminate the formula from cell C26 by clicking the cell and pressing
[Delete], then [Enter].
16 Add appropriate border formats to cell C29.
17 Repeat Steps 12 to 16 in column E, substituting E for C in all column
references. The liability and equity part of your worksheet should look
like Figure 3.3.
18 Switch to a Page Layout view. Place your name in the left section of
the footer. Note that the file name is already in the right section of the
footer.
19 Switch back to a Normal view.
20 Click File and then click Print to make sure the worksheet will print
the way you want.
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Figure 3.3
Balance Sheet Liabilities
and Equities Vertical
Analysis

21 Click Print to print your analysis.
22 Save your file but do not close it.

Once again Meagan notes some interesting facts from the vertical analysis of
the balance sheet. A larger percentage of total assets are invested in accounts receivable and inventory than in the prior year. Yet long-term debt is down, offset
by an increase in retained earnings as a percentage of total assets.
To complete the vertical analysis, you offer to demonstrate Excel’s charting
capability by creating a pie chart of expenses for the year ended December 31,
2016.

Pie Charts
‘‘Excel’s chart wizard makes creating a chart from a worksheet a breeze,’’ you
remark. ‘‘This will give you a graphical picture of the firm’s expenses as a percentage of revenues.’’

To create a pie chart of expenses:
1 Click on Income Statement worksheet tab and select cells D9
through D14.
2 Click the Insert tab on the Ribbon and then click the Pie Chart tool
on the Charts group.
3 Select 3-D Pie as shown in Figure 3.4. Trouble? If your window is
too small you may not see Pie as an option in the Charts group and
instead will only see the text Charts. Widen the window to reveal the
chart options available or click the Charts group and select Pie.

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Financial Statement Analysis

Chapter 3

65

Figure 3.4
Creating a New Pie Chart

4 In the Chart Layouts group select Style 6. See Figure 3.5. Your
window may look different if it is sized larger. If so just select Layout
6 from the Chart Layouts group.

Figure 3.5
Modifying a Chart Layout
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5 Double-click the text Chart Title and then type 2016 Expenses as the
new chart title.
6 Click the Select Data tool in the Data group.
7 Click Edit under the text Horizontal (Category) Axis Labels as shown
in Figure 3.6.

Figure 3.6
Editing the Pie Chart
Axis Labels

8 Type =‘Income Statement’!$A$9:$A$14 as the Axis label range and
then click OK. (Alternatively, you could click the button on the righthand side of the window and then select the range A9:A14 instead of
typing the cell location.)
9 Click OK to close the Select Data Source window.
10 Click anywhere in the chart and, holding the mouse button down, drag
the new chart so that it appears below the data.
11 Click in the lower right-hand corner of the chart and, holding the
mouse button down, resize the chart so that it fits in the window; see
Figure 3.7.
12 With the chart still selected, click File and then click Print to make
sure the chart will print the way you want.
13 Click Print to then print the chart.
14 Save your work and then close the file.
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Figure 3.7
Pie Chart and Vertical
Analysis Income
Statement

You have now completed the vertical analysis. Nathan and Meagan are eager
to examine the percentages and the chart more carefully, but not until they see
how horizontal and ratio analyses can be created in Excel.

Horizontal Analysis
Horizontal analysis examines trends over time. This can include comparisons of
months, quarters, or years for both the income statement and the balance sheet.
Income statements and balance sheets for two or more periods are compared side
by side, and a percentage increase or decrease is computed between periods.
‘‘Isn’t that what we just did in vertical analysis?’’ Meagan asks. Kyle replies:
‘‘The percentages computed in vertical analysis are usually done for just one period, although they are often compared period to period. Remember, vertical
analysis compares each statement element with a single base amount, such as
sales or total assets, whereas horizontal analysis compares elements side by side
with other periods.’’

To create a horizontal analysis on an income statement:
1 Open ch3-01 (This is the same file you opened for vertical analysis. It
should still look the same, because the changes you made were saved
under another file name.)
2 Click the Home tab on the Ribbon and then click the Income
Statement worksheet tab.
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3 Click cell D4 and type % Change as a label to the column.
4 Format cell D4 bold, center, bottom align, and with a bottom border.
5 Click cell D5 and type the formula =(C5–B5)/B5; then press [Enter].
6 Format cell D5 as Percent Style by clicking cell D5 and selecting the
Percent Style tool on the Number group on the Home tab.
7 Use the fill-down procedure to copy the formula from D5 to D17.
8 Delete the formula in cell D8.
9 Format cells D6 and D14 with a bottom border.
10 Format cell D17 with a top and double bottom border.
11 Resize column D to 96 pixels. Your completed income statement with
horizontal analysis should look like Figure 3.8.

Figure 3.8
Income Statement
Horizontal Analysis

12 Click File and then click Save As. (Again, this preserves the original
file by giving a unique name to your file.)
13 Change the file name to include a reference to your horizontal
analysis, and then add your name to the file name using the underscore key as before. In this example, the file will be saved as
ch3-01_Horizontal_Analysis_student_name (replace student_name
with your name). Save your file to a location from which it can be
retrieved later.
14 Switch to a Page Layout view. Place your name in the left section of
the footer. Note that the file name is already in the right section of the
footer.
15 Switch back to a Normal view.
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16 Click File and then Print to make sure the worksheet will print the
way you want.
17 Click Print to print your analysis.
18 Save your file but do not close it.
‘‘The trends shown here are good and bad,’’ Nathan says. ‘‘The analysis
reveals an increase in sales of 15 percent but a 35 percent increase in the costs
of goods sold.’’
Kyle explains that the income statement analysis reveals operational and
profitability performance and trends while the balance sheet reflects financial
stability and solvency trends. The horizontal analysis on the balance sheet compares current balances for each asset, liability, and equity element with the same
element in the prior period.

To create a horizontal analysis on a balance sheet:
1 Click the Home tab on the Ribbon and then click the Balance Sheet
worksheet tab.
2 Click in cell D5 and type % Change as a label to the column.
3 Format cell D5 bold, center, bottom align, and with a bottom border.
4 Click in cell D7 and type the formula =(C7–B7)/B7; then press
[Enter].
5 Format cell D7 as Percent Style.
6 Use the fill-down procedure to copy the formula from D7 to D29.
7 Delete the formula in cells D12, D18–D21, and D26.
8 Format cells D17 and D29 with a top and double bottom border.
9 Resize column D to 93 pixels. Your completed balance sheet horizontal analysis should look like Figure 3.9.
10 Switch to a Page Layout view. Place your name in the left section of
the footer. Note that the file name is already in the right section of the
footer.
11 Switch back to a Normal view.
12 Click File and then Print to make sure the worksheet will print the
way you want.
13 Click Print to print your analysis.
14 Save your file once again.
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Figure 3.9
Balance Sheet
Horizontal Analysis

‘‘I’m a little concerned about the 22 percent growth in accounts receivable,
the 21 percent growth in inventory, and the 33 percent decrease in cash,’’ Meagan
says. Kyle reminds her that, when those events occurred, long-term debt
decreased 13 percent and retained earnings increased 25 percent. ‘‘Excel can also
provide some graphical evidence of these trends by creating column charts using
the chart wizard,’’ Kyle says.

Column Charts
Previously you created a pie chart of expenses using Excel’s Chart Wizard.
Now it is time to create a column chart comparing expenses from one period to
the next. This column chart will illustrate expenses side by side for the two
years ended December 31, 2015, and December, 31, 2016.
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To create a column chart comparing expenses:
1 Click the Income Statement worksheet tab.
2 Select cells A9 through C14 (expenses for both periods).
3 Click the Insert tab on the Ribbon and then click the Column chart
tool from the Charts group.
4 Select 3-D Column as the chart type as shown in Figure 3.10.

Figure 3.10
Creating a Column
Chart

5 Click and hold down the mouse on the top border of the chart created;
then move the chart to a location below the data.
6 Scroll down the worksheet so that row 8 is at the top of your screen
and the chart is fully visible, as shown in Figure 3.11.
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Figure 3.11
Modifying a Column
Chart

7 Note that the Design tab is now selected and Chart Tools are visible
in the Ribbon.
8 Click Select Data from the Data group.
9 Click Series1 from the Legend Entries (Series) section
(see Figure 3.12).
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Click here to edit
series name

Figure 3.12
Editing a Data Source

10 Click Edit.
11 Click inside the Series name text box and the click in cell B4. This
should enter the formula =‘‘Income Statement’’!$B$4 the Series name
text box. Click OK.
12 Click Series2 from the Legend Entries (Series) section.
13 Click Edit.
14 Click inside the Series name text box and the click in cell C4. This
should enter the formula =‘‘Income Statement’’!$C$4 into the Series
name text box. Click OK.
15 Click OK again in the Select Data Source window.
16 Click Quick Layout from the Charts Layouts group and then Click
Layout 1. Your window may look different if it is sized larger. If so
just select Layout 1 from the Chart Layouts group.
17 Type Expense Comparison as the new chart title.
18 Click File and then click Save As.
19 Change the file name to include a reference to column charts, and
add your name to the file name using the underscore key as you have
done previously. In this example, the file will be saved as ch3-01_
Column_Chart_student_name (replace student_name with your name).
Be sure to save your file to a location that you can access later.
20 Click File and then click Print, and, then click Print again to
print the worksheet with the chart. Your printout should look like
Figure 3.13.
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Figure 3.13
Printed Income Statement
with Expense Comparison
Chart

21 Save your work again.

‘‘All of this is very interesting,’’ says Nathan. ‘‘I’ll bet there’s more. Am I
right?’’ ‘‘Yes, we still need to do a ratio analysis in order to complete our financial statement analyses portfolio,’’ Kyle responds.

Ratio Analysis
Kyle explains that several standard ratios are often used to assess a company’s
profitability, liquidity, and solvency. Profitability represents the company’s ability to generate a profit to investors. Liquidity represents the company’s ability
to pay its bills currently. Solvency represents the company’s ability to stay in
business given its debt structure. A chart of each ratio’s formula follows.

Copyright 2014 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s). Editorial review has
deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Financial Statement Analysis

Chapter 3

75

Profitability

Return on owners’ investment
Return on total investment
Profit margin
Gross margin

Net income  Average stockholders’ equity
Net income before interest expense 
Average total assets
Net income  Sales
Gross margin  Sales

Liquidity

Current ratio
Quick ratio
Receivable turnover
Inventory turnover

Current assets  Current liabilities
(Cash þ Accounts receivable þ Short-term
investments)  Current liabilities
Sales  Average accounts receivable
Cost of goods sold  Average inventory

Solvency

Debt-to-equity
Liability

Total liabilities  Total equity
Total liabilities  Total assets

In Excel, each of these amounts is a part of a given financial statement or
can easily be computed. Therefore, you can create a new worksheet that has
formulas referencing these amounts. Kyle suggests you create a new worksheet
to compute these ratios.

To calculate the first financial ratio on a new worksheet
(refer to preceding ratio table for the return on owners’
investment formula):
1 Right-click the Income Statement tab of your workbook and click Insert
. . .; then click Worksheet and then OK to insert a new worksheet.
2 Double-click the Sheet1 tab and rename the worksheet Ratio Analysis.
3 Format the Ratio Analysis worksheet like Figure 3.14 with a heading
and listing of ratios as shown. To center and merge the title, select the
range of cells A1:B1 and then click the Merge and Center button
from the Alignment group on the Home tab of the Ribbon. Repeat
these steps for the ranges A2:B2 and A3:B3.
4 Click in cell B6 and type the following 5‘Income Statement’!C17/
((‘Balance Sheet’!B271‘Balance Sheet’!B281‘Balance Sheet’!C271
‘Balance Sheet’!C28)/2) to compute return on owners’ investment.
5 Alternatively, you could utilize multiple worksheet referencing.
Type = in cell B6, then activate the income statement worksheet and
click cell C17.
6 Type /(( (the forward slash and two left parentheses, which determine
the all-important order of calculation).
7 Activate the balance sheet worksheet and click cell B27.
8 Type 1, then click cell C27.
9 Type 1, then click cell B28.
10 Type 1, then click cell C28.
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Figure 3.14
Format for Ratio Analysis

11 Type )/2) to end the summation of equity accounts and divide the
result by 2 to derive an average.
12 Press [Enter] to end your formula.
13 Format cell B6 in a percent style.

T r o u b l e ? If you choose to type the formula as written here and
forget an apostrophe or exclamation point or misspell a word, then
Excel will give you an error message and you’ll have to debug your
formula. Also, if you don’t have the correct number of parentheses,
Excel will give you an error message. Note that when you edit the formula, Excel changes the color of each set of parentheses so that you
can clearly see which is which. Also be careful when typing formulas
to use the apostrophe and not the accent key to create formulas. The
apostrophe key is usually located next to the Enter key on your keyboard, and the accent key is usually located above the Tab key.

‘‘The point-and-click method of cell referencing on multiple worksheets is sure
easier than typing the references themselves,’’ you comment. ‘‘Otherwise I would
have to type all of those apostrophes and exclamation points. With my typing
skills, I would probably forget one of them and create an error in the formula.’’
‘‘Good point,’’ Kyle says. ‘‘Let’s finish the profitability ratios next.’’

To enter remaining formulas for profitability analysis (refer to
the ratio table for these formulas):
1 Click cell B7 and type =.
2 Use the values at cells C17 and C11 on the income statement to compute net income before interest expense, which is the numerator of the
return on total investment ratio.
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3 Use the values at cells B17 and C17 on the balance sheet to add total
assets, and then divide the result by 2 to obtain average total assets.
4 Once your formula is typed, press [Enter] to compute the ratio. Your
formula should look like this: =(‘Income Statement’!C171‘Income
Statement’!C11)/((‘Balance Sheet’!B171‘Balance Sheet’!C17)/2).
Be careful to use the correct parentheses.
5 Format the cell in percent style.
6 In cell B8, use the values at cells C16 and C5 on the income statement
to compute the profit margin. (Use the ratio table to enter the appropriate
formula.) Your formula should look like this: =‘Income Statement’!C17/
‘Income Statement’!C5.
7 Format the cell in percent style.
8 In cell B9, use the values at cells C7 and C5 on the income statement
to compute the gross margin. (Use the ratio table to enter the appropriate formula.) Your formula should look like this: = ‘Income Statement’!C7/ ‘Income Statement’!C5.
9 Format the cell in percent style. Your window should look like Figure 3.15.

Figure 3.15
Profitability Analysis
Completed

10 Click File then click Save As.
11 Change the file name to include a reference to ratios, and then add
your name to the file name using the underscore key as before. In this
example, the file will be saved as ch3-01_Ratios_student_name
(replace student_name with your name). Be sure to save your file to a
safe location.
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Remember, profitability ratios measure the company’s ability to generate a
profit to investors. In this case, Nathan and Meagan are fairly satisfied with
their profitability in comparison to other companies of their size and type of
business. They are eager to see if their liquidity ratios are equally as positive.
Kyle encourages you to continue with your ratio analysis.

To compute the liquidity ratios:
1 In cell B11, use the values in cells C7 through C11 (current assets) and
C22 through C23 (current liabilities) on the balance sheet to compute
the current ratio. (Use the ratio table to find the appropriate formula.)
Your formula could be =(‘Balance Sheet’!C71‘Balance Sheet’!C81
‘Balance Sheet’!C91‘Balance Sheet’!C101‘Balance Sheet’!C11)/
(‘Balance Sheet’!C221‘Balance Sheet’!C231‘Balance Sheet’!C24),
where current assets and current liabilities are added up separately; or you
could use the SUM function and write the formula as =SUM(‘Balance
Sheet’!C7:C11)/SUM(‘Balance Sheet’!C22:C24).
2 Format the cell in comma style.
3 In cell B12, use the values in cells C7–C8 (cash and accounts receivable) and C22–C23 (current liabilities) on the balance sheet to compute
the quick ratio. (Refer to the ratio table for the appropriate formula.)
Your formula could be either =(‘Balance Sheet’!C71‘Balance Sheet’!
C8)/(‘Balance Sheet’!C221‘Balance Sheet’!C231‘Balance Sheet’!
C24) or =SUM(‘Balance Sheet’!C7:C8)/SUM(‘Balance Sheet’!
C22:C24).
4 Format the cell in comma style.
5 In cell B13, use the values in cell C5 (sales revenue) on the income statement and cells B8 and C8 (accounts receivable) on the balance sheet to
compute the receivable turnover ratio. (Use the ratio table to find the
appropriate formula.) Your formula should look like this: =‘Income
Statement’!C5/((‘Balance Sheet’!B81‘Balance Sheet’!C8)/2).
6 Format the cell in comma style.
7 In cell B14, use the values in cell C6 (cost of goods sold) on the
income statement and cells B9 and C9 (inventory) on the balance sheet
to compute the inventory turnover ratio. (Use the ratio table to find the
appropriate formula.) Your formula should look like this: =‘Income
Statement’!C6/((‘Balance Sheet’!B91‘Balance Sheet’!C9)/2).
8 Format the cell in comma style.
9 Save your work.
Remember, the liquidity ratios measure the company’s ability to pay its bills
currently. In this case, Nathan and Meagan are surprised at how good their current and quick ratios are. Usually, their current ratio is around 2:1, which is
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normal. The 2.69 current ratio and the 1.11 quick ratio indicate they have plenty
of resources to meet their current liabilities. Receivable turnover is a little low,
given they have 30-day credit terms, but this is still a healthy report. Inventory
turnover is a little slow at 4.29, but this is fairly common in their business.
They are eager to see if the solvency ratios continue the favorable trend.

To compute the solvency ratios:
1 In cell B16, use the values in cells C22 through C25 (accounts payable,
notes payable, payroll liabilities, and long-term debt) and C26 and C27
(common stock and retained earnings) on the balance sheet to compute
the debt-to-equity ratio. (Refer to the ratio table for the appropriate
formula.) Your formula should look like this: =SUM(‘Balance Sheet’!
C22:C25)/SUM(‘Balance Sheet’!C27:C28).
2 Format the cell in percent style.
3 In cell B17, use the values in cells C22 through C25 (accounts payable,
notes payable, payroll liabilities, and long-term debt) and C17 (total
assets) on the balance sheet to compute the liability ratio. (Refer to the
ratio table for the appropriate formula.) Your formula should look like
this: =SUM(‘Balance Sheet’!C22:C25)/‘Balance Sheet’!C17.
4 Format the cell in percent style. Your completed work should look like
Figure 3.16.

Figure 3.16
Completed Ratio Analysis

5 Save your work.
Now the news is not as good. It turns out the positive liquidity ratio is somewhat offset by the solvency ratios, which indicate that debt is 183 percent of
equity. The company is financed heavily with debt, and this can lead to problems
if the return on investment doesn’t exceed the cost of the debt. The liability ratio
reflects the same problem in that 65 percent of the company’s assets are financed
with debt versus equity. Nathan’s business plan calls for a reduction in debt over
the next several years as profits provide the necessary cash.
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‘‘This is great,’’ Meagan says. ‘‘Although the solvency ratios are high, they
do reflect our business plan. As long as we continue to generate profits and
cash flow, we should be able to improve the solvency ratios.’’

End Note
You’ve applied some of what you learned in the first two chapters to create
a set of useful worksheets that identify trends and relationships. Plus you’ve
created them in a reusable format for future periods.
In the next chapter, you will learn how to use Excel to perform depreciation
calculations and prepare depreciation schedules.
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practice
1

What is another term for vertical analysis?

2

What base amount is used for vertical analysis of an income statement?

3

What base amount is used for vertical analysis of a balance sheet?

4

What base amount is used for horizontal analysis of both income statements and balance sheets? Give an example.

5

What do profitability ratios represent?

6

What do liquidity ratios represent?

7

What do solvency ratios represent?

8

Why is the point-and-click method of cell referencing easier than typing
references directly into worksheet cells?

9

Which ratios are usually formatted as percentages?

10

3

Which ratios are usually formatted as numbers?

Chapter 3 Assignments
1

Create a Financial Analysis for What SUP, Inc. as of December 31, 2016.
You are to create this financial analysis as of December 31, 2016, from
the information found on file ch3-02.xls. This file contains three worksheets, which are labeled Income Statement, Balance Sheet, and Ratios.
Following the Chapter 3 examples, create a vertical analysis of both the
income statement and balance sheet for December 31, 2016, only. Then
create a horizontal analysis of both the income statement and balance
sheet. (Note: The horizontal analysis will compare December 31, 2015,
with December 31, 2016.) In addition, create a pie chart of expenses
for the year ended December 31, 2016; a column chart (in a format of
your choice) of expenses for the years ended December 31, 2015, and
2016; and a ratio analysis as of December 31, 2016. Save the file as
ch3-02_student_name.xls (replacing student_name with your name).
a.

Print each completed worksheet in Value view, with your name and date
printed in the lower left footer and the file name in the lower right footer.

b.

Print each completed worksheet in Formula view, with your name
and date printed in the lower left footer and the file name in the
lower right footer.
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2

Create a Financial Analysis for What SUP, Inc. as of December 31,
2017.
You are to create What SUP’s financial analysis as of December 31, 2017,
from the information found on file ch3-03.xls. This file contains three
worksheets, which are labeled Income Statement, Balance Sheet, and
Ratios.
Following the Chapter 3 examples, create a vertical analysis of both the
income statement and balance sheet for December 31, 2017, only. Then
create a horizontal analysis of both the income statement and balance
sheet. (Note: The horizontal analysis will compare December 31, 2016,
with December 31, 2017.) In addition, create a pie chart of expenses
for the year ended December 31, 2016; a column chart (in a format of
your choice) of expenses for the years ended December 31, 2016, and
2017; and a ratio analysis as of December 31, 2018. Save the file as
ch3-03_student_name.xls (replacing student_name with your name).
a.

Print each completed worksheet in Value view, with your name and
date printed in the lower left footer and the file name in the lower
right footer.

b.

Print each completed worksheet in Formula view, with your name
and date printed in the lower left footer and the file name in the
lower right footer.

Chapter 3 C ase P roblem 1:

KELLY’S BOUTIQUE
You are to create Kelly’s Boutique’s financial analyses as of December 31,
2014, and as of December 31, 2015. Following the Chapter 3 examples, use the
student file ch3-04.xls to create a vertical and horizontal analysis of the balance
sheet and income statement in the columns provided. (Note: The horizontal
analysis will compare December 31, 2014, with December 31, 2015.) Also create a pie chart of expenses for the year ended December 31, 2015; a column
chart of expenses for the years ended December 31, 2014, and December 31,
2015; and a ratio analysis as of December 31, 2015. Save the file as
ch3-04_student_name.xls (replacing student_name with your name).
a.

Print each completed worksheet in Value view, with your name and
date printed in the lower left footer and the file name in the lower
right footer.

b.

Print each completed worksheet in Formula view, with gridlines and
row and column headings, portrait orientation, scaling to fit to 1 page
wide by 1 page tall, and with your name and date printed in the lower
left footer and the file name in the lower right footer.
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Chapter 3 Case Problem 2:

WINE DEPOT
You are to create Wine Depot’s financial analyses as of December 31, 2015,
and as of December 31, 2016. Following the Chapter 3 examples, use the student file ch3-05.xls to create a vertical and horizontal analysis of the balance
sheet and income statement in the columns provided. (Note: The horizontal
analysis will compare December 31, 2015 with December 31, 2016.) Also create a pie chart of expenses for the year ended December 31, 2016; a column
chart of expenses for the years ended December 31, 2015, and December 31,
2016; and a ratio analysis as of December 31, 2016. Save the file as
ch3-05_student_name.xls (replacing student_name with your name). Note: You
will have to use Excel’s help feature to create the column chart, because the
columns are not adjacent to one another as in the chapter example. Use whatever chart layout you prefer.
a.

Print each completed worksheet in Value view, with landscape orientation, scaling to fit to 1 page wide by 1 page tall, and with your
name and date printed in the lower left footer and the file name in the
lower right footer. Use Excel’s help feature to move charts on your
worksheet so that they print on a separate page.

b.

Print each completed worksheet in Formula view, with gridlines and
row and column headings, landscape orientation, scaling to fit to 1
page wide by 1 page tall, and with your name and date printed in the
lower left footer and the file name in the lower right footer.

Chapter 3 Case Problem 3:

SNICK’S BOARD SHOP
You are to create a financial analysis for Snick’s Board Shop as of December
31, 2011, and December 31, 2012. Following the Chapter 3 examples, use the
student file ch3-06.xls to create a vertical and horizontal analysis of the balance
sheet and income statement in the columns provided. (Note: The horizontal
analysis will compare December 31, 2011, with December 31, 2012.) Also create a pie chart of expenses for the year ended December 31, 2012, formatted in
a manner similar to your chapter work; a column chart of expenses for the years
ended December 31, 2011, and December 31, 2012, formatted in a manner similar to your chapter work; and a ratio analysis as of December 31, 2012. Save
the file as ch3-06_student_name.xls (replacing student_name with your name).
Note: You will have to use Excel’s help feature to create the column chart,
because the columns are not adjacent to one another as in the chapter example.
Use whatever chart layout you prefer.
a.

Print each completed worksheet in Value view, with landscape orientation, scaling to fit to 1 page wide by 1 page tall, and with your
name and date printed in the lower left footer and the file name in the
lower right footer.
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b.

Print each completed worksheet in Formula view, with gridlines and
row and column headings, landscape orientation, scaling to fit to 1
page wide by 1 page tall, and with your name and date printed in the
lower left footer and the file name in the lower right footer.

Chapter 3 C ase P roblem 4:

ROSEY’S ROSES
You are to create a financial analysis for Rosey’s Roses as of December 31,
2013, and December 31, 2014. Following the Chapter 3 examples, use the student file ch3-07.xls to create a vertical analysis of the balance sheet and income
statement as of December 31, 2013, and December 31, 2014—as well as a horizontal analysis of both the income statement and balance sheet comparing
December 31, 2013, with December 31, 2014. Place the vertical analysis in
columns D and G on the income statement labeled % of Sales in cells D5 and
G5. Place the vertical analysis in columns D and G on the balance sheet labeled
% of Assets in cells D5 and G5. Place the horizontal analysis in column I
labeled % Change in cell I5 for both the income statement and balance sheet.
Also create a pie chart of expenses for the year ended December 31, 2014,
formatted in a manner similar to your chapter work; a column chart of expenses
for the years ended December 31, 2013, and December 31, 2014, formatted in a
manner similar to your chapter work; and a ratio analysis as of December 31,
2014. Note: You will have to use Excel’s help feature to create the column
chart, because the columns are not adjacent to one another as in the chapter
example. Use whatever chart layout you prefer.
Save the workbook as ch3-07_student_name (replacing student_name with
your name). Print all worksheets in Value view, with your name and date
printed in the lower left footer and the file name in the lower right footer.
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